# Table of Contents

Safeguards and Precautions .................................................. 5  
Introduction ........................................................................ 7  
The Quiz Bowl Components .................................................. 8  
Instant Quiz Bowl ............................................................... 10  
Using the Quiz Bowl Software .............................................. 12
  Install the Software ........................................................... 12
  Windows Installation ......................................................... 12
  Macintosh Installation ........................................................ 14
Create a Game ....................................................................... 15
  A. Set Up the Game Play Information ................................. 15
  B. Set Up the Teams .......................................................... 16
  C. Game Questions ........................................................... 19
The Question Bank ............................................................... 21
  Access the Question Bank .................................................. 21
  Working with Questions in the Question Bank ..................... 21
  Export or Import Games and Questions .............................. 23
Print a Game ......................................................................... 25
Download Games to the Master Scoreboard ......................... 25
Update the Quiz Bowl Master Scoreboard’s Firmware ............... 26
Playing a Game ................................................................. 27
  Connect the Components ................................................... 27
  Become Familiar with the Host Remote Control .................. 28
    POWER ........................................................................ 28
    BEGIN ........................................................................ 28
    UP ............................................................................. 28
    DOWN ......................................................................... 28
    CORRECT .................................................................... 28
    INCORRECT .................................................................. 28
    QUESTION ................................................................... 29
    SCORE ........................................................................ 29
  Power up the Quiz Bowl System .......................................... 29
  Select a Game .................................................................... 29
  Register the Players ......................................................... 30
  Play the Game ................................................................... 31
Game Play Options ............................................................ 33
  Selecting a New Game ....................................................... 33
  Selecting Questions .......................................................... 33
  Selecting a Bonus or Tie-Breaker Question ........................... 33
  Display Scores ................................................................... 34
SAFEGUARDS AND PRECAUTIONS

CAUTION

Please read the following information before using your Quiz Bowl Scoreboards. The Scoreboards have been engineered and manufactured with safeguards to assure your personal safety. But improper use can result in potential electrical shock or fire hazards. Observe the following safety rules for the Scoreboard installation and use.

1. Operate only from a power source indicated on the Master Scoreboard or in this guide.

2. When it is plugged in, the Master Scoreboard will briefly show the Quiz Bowl firmware version number. If the Master Scoreboard detects any problems at initial startup, it will display an error message with the format E###, where the ### represents the error number. Refer to the Troubleshooting Section in this guide for an explanation of some of the error numbers.

3. Your Quiz Bowl Master Scoreboard is supplied with a 110/240VAC-50/60Hz power adapter with a DC output of 9V-1.5A. The use of any other power supply will void the warranty and may severely damage the unit.

4. Protect and route power cords so that nothing rests on or rolls over them. Be especially careful at plug-ins, convenience receptacles, or cord exit points. Frayed power cords or damaged plugs are hazardous and should be replaced by a qualified service technician. Overloaded wall outlets and extension cords may cause fire or electrical shock hazards.

5. Do not cover or block ventilation holes in the Master Scoreboard. Doing so may cause heat build-up, which may damage the equipment or create a fire hazard.

6. Do not place the Master Scoreboard on a soft surface, which could block ventilation holes on the bottom. Avoid enclosed installations, such as bookshelves or racks, unless ventilation is adequate. Never place the Master Scoreboard near or over a radiator or heat register nor on a sloping shelf.

7. Avoid excessive humidity, sudden temperature changes, or temperature extremes.
8. To avoid costly damage or injury, place the Master Scoreboard on a solid, stable surface that is free from vibrations, and do not place any heavy object on it.

9. Keep the Master Scoreboard away from wet locations, such as bathtubs, sinks, and swimming pools.

10. If the Master Scoreboard has been exposed to rain, moisture, or liquids, unplug it and allow it to dry before further use. Rain or excessive moisture may cause electrical shorts, which can result in fire or shock hazards.

11. It is recommended that the Master Scoreboard be unplugged during a lightning storm or if it will not be used for an extended period of time.

12. Unplug the Master Scoreboard before cleaning. Use a water-dampened cloth for cleaning. Do not use cleaning fluids or aerosols. They could enter the Scoreboard and cause damage, fire, or electrical shock.

13. Do not insert foreign objects into the Scoreboards. Never operate the Scoreboard if any foreign object has entered it. Electrical shorts can result, causing fire or shock hazards. Unplug the Scoreboards immediately and contact Educational Insights Customer Service.

14. During operation, Quiz Bowl is subject to the following two conditions: it may not cause harmful interference, and it must accept any interference received, including interference that may cause undesired operation. Quiz Bowl remotes use R/F to communicate with the Master Scoreboard and comply with Part 15 of the FCC Rules of Operation. The Master Scoreboard signal decoder may not work properly if the remotes are operated in close proximity to electronic items that emit large amounts of R/F emissions. Under normal conditions, the Host and Player Remote Controls operate at a range of up to 50 feet from the Master Scoreboard.

15. **NOTE:** This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

   - Reorient or relocate the receiving antenna.
   - Connect the equipment into a different outlet from the receiver.
   - Increase the separation between the equipment and receiver.
   - Consult the dealer or an experienced radio/TV technician for help.

**NOTE:** The user is cautioned that changes and modifications made to the equipment without the approval of manufacturer could void the user’s authority to operate this equipment.
**Quiz Bowl is an innovative way to PLAY your way to student success with questions YOU create!**

Bring the excitement of academic competitions to your classroom with Quiz Bowl, an interactive educational electronic game. Patterned after classic competitions like College Bowl; Scholastic Bowl; and University Challenge, Quiz Bowl brings this exciting game to your own classroom. But there’s one important difference: YOU write the content to align with YOUR students’ learning needs. From the moment you set up the Scoreboards and pass out the player remotes, your students will be enthusiastically competing to learn!

Game play is easy. Plug in and connect the Scoreboards and distribute the ten player remotes—five per team. Ask a question and then wait for students to signal in using their student remotes. The Scoreboard indicates which player signaled in first. Wait for that student’s answer and then press ‘correct’ or ‘incorrect’ on your host remote. The Scoreboards tally the scores and display the current scores after every question. At the end of the game, the Scoreboards display the final scores and the winning team’s score flashes. Running out of class time? The games can be paused and played at a later time or date; Quiz Bowl remembers where you left off!

It’s easy to use the Quiz Bowl software to write games tailored to your students’ needs. Use the easy-to-follow interface to input content into your computer. Then download the information to Quiz Bowl’s Master Scoreboard and let the competition begin! Want to play Quiz Bowl right out of the box? Two ready-to-play games were pre-installed at the factory so you can play a 10-question or 20-question game right away and see how much fun it is!

Some of Quiz Bowl’s innovative features include:

- the ability to conduct contests and tournaments between students, classrooms, school districts, and states nationwide.
- totally wireless communication between players and the Master Scoreboard.
- self-authoring user-friendly computer software to create games, enter player names, write questions, and even assign point values for individual questions.
- player names displayed on the Scoreboard when they signal in.
- option to purchase an additional Scoreboard and/or additional student remotes. The system can accommodate up to 45 individual players!
THE QUIZ BOWL COMPONENTS

A. Master Scoreboard
B. Accessory Scoreboard
C. AC Power Adapter
D. Signal and Power Cable
E. USB Cable
F. Host Remote Control
   (requires 2 AAA batteries not included)
G. Ten Player Remotes
   (requires 20 AAA batteries not included)
H. CD-ROM containing the Quiz Bowl software,
   a Teacher’s Guide, and sample games.
I. Dry-Erase Marker
J. Screwdriver

A. Master Scoreboard* with white write on/wipe off surface for team names.
B. Accessory Scoreboard with white write on/wipe off surface for team names.

C. AC Power Adapter
   connects the Master Scoreboard Unit to a power outlet.

*Note: Please check our website at www.EducationalInsights.com for the latest upgrades to the Master Scoreboard firmware (see page 26).
I. Dry-Erase Marker is used to write team names on the Scoreboards.

J. Screwdriver for installing AAA batteries in the Host Remote and Player Remotes.

D. Signal and Power Cable connects the Master Scoreboard to the Accessory Scoreboard for communication and power to the Accessory Scoreboard.

E. USB Cable connects the Master Scoreboard to a computer to download games. (This cable also enables you to upgrade the firmware on your Master Scoreboard if new versions become available.)

F. Host Remote Control allows the game host to move through the game and identify responses as correct or incorrect.

G. Player Remotes enable players to “signal in” when they’re ready to answer.

H. CD-ROM* includes the Quiz Bowl software, a Teacher’s Guide, and sample games.

*Note: Please check our website at www.EducationalInsights.com for the latest upgrades to this software.
INSTANT QUIZ BOWL

You can play Quiz Bowl right out of the box! Two ready-to-play games (Instant Quizzes) were installed on the Master Scoreboard at the factory.

The pre-installed Instant Quizzes are displayed as IQ-10 and IQ-20 on the Master Scoreboard.

• IQ-10 has ten 100-point questions.
• IQ-20 has twenty 500-point questions.

The questions in the game are only point holders. No actual questions and answers have been written into the games. You will need a list of 10 or 20 questions to ask your players. Neither of these games is editable, but they can be played multiple times without reloading after they have been played.

Follow these instructions to play the Instant Quiz games.

Set up the Quiz Bowl System
1. Connect the components. (See the diagram on page 27.) When you connect the AC power adapter to the power source and Master Scoreboard, it briefly flashes 3xxx (where xxx is the firmware version number you have).
2. Put batteries in the Player Remotes and in the Host Remote Control. (See page 46 for battery installation instructions.)

Select an Instant Quiz Bowl Game
1. Press the POWER key on the Host Remote.
2. Press the BEGIN key. The Master Scoreboard displays IQ-10.
3. Press the DOWN arrow key to display IQ-20. (Repeat pressing the DOWN key to cycle between the IQ-10 and IQ-20 games.)
4. Press the BEGIN key to start the game displayed on the Master Scoreboard.

Register Team Players
1. Press the BEGIN key again to begin Player Registration. -TM1- is displayed on the Master Scoreboard, and -TM2- is displayed on the Accessory Scoreboard. (If the displays on the Scoreboards are reversed, turn off the power on the Host Remote, transfer the Signal and Power Cable to the opposite jack on the Master Scoreboard, and then repeat steps 1-4 above.)
2. Press BEGIN again. PLR-1 is displayed on the Master Scoreboard. Instruct the first player of Team 1 to press the button on the top of his or her Player Remote. The Scoreboard will beep and its indicator light will flash green.
3. Press the DOWN arrow key on the Host Remote. The Master Scoreboard will display PLR-2. Instruct the second player of Team 1 to press the button on the top of his or her Player Remote. The Scoreboard will beep and its indicator light will flash green.
4. Repeat steps 2 and 3 for up to five players. However, you do not need five players to play a game; you can play with as few as one player. After the final player of Team 1 has registered successfully, keep pressing the \textbf{BEGIN} button until the \textbf{Accessory Scoreboard} displays $\text{PLR}^{1}$. 

5. Repeat the registration process for the players on Team 2.

6. When you are finished registering players, press \textbf{BEGIN}. If you registered fewer than ten players, the Scoreboards flash $\text{-C1H-}$ (check) to double check that you are finished with registration. If you are NOT finished with registration, press the \textbf{UP} or \textbf{DOWN} keys to cycle through and enter additional players.

\textbf{Play the Game}

1. Press the \textbf{BEGIN} key on the \textbf{Host Remote}. All Scoreboards will flash the first question number and then the scores.

2. Read the first question aloud.

3. Press the \textbf{BEGIN} key to start the signal-in countdown. (All the questions in the IQ-10 and IQ-20 games have a signal-in time of ten seconds.) The Scoreboards will start counting down from 10.

   Once \textbf{BEGIN} is pressed on the \textbf{Host Remote}, students may signal in by pressing the button on their Player Remotes. \textit{Note:} Students should NOT signal in before the \textbf{BEGIN} key is pressed on the \textbf{Host Remote}. If any student presses and holds down the button on the Player Remote so that it is depressed before, during, and after the teacher presses \textbf{BEGIN}, that student’s remote will be ‘locked out’ and unable to signal in until he/she has released the button for one whole second. (A student will also be locked out if he/she rapidly presses the button on the Player Remote before \textbf{BEGIN} is pressed.) Caution students to wait until you press \textbf{BEGIN} before signaling in to answer a question.

4. At this point there are three possibilities:

   a. No player signals in. In this case, the question is skipped and the number of the next question is briefly displayed on the Scoreboards, followed by the scores. Press \textbf{BEGIN} to start the signal-in countdown for the new question.

   b. A player signals in and answers the question correctly. In this case, press the \textbf{CORRECT} key on the \textbf{Host Remote}. Then press \textbf{BEGIN} again to lock in the new score. The light on the player’s Scoreboard flashes green, and his or her team’s score is adjusted. The next question number is briefly displayed. The system is ready for the next question when the indicator lights illuminate and the current scores are displayed. Press \textbf{BEGIN} to start the signal-in countdown for the new question.

   c. A player signals in and answers the question incorrectly. In this case, press the \textbf{INCORRECT} key on the \textbf{Host Remote} and press \textbf{BEGIN} to lock in the score. The light on the player’s Scoreboard turns red and the Scoreboard becomes inactive. The light on the other Scoreboard illuminates, indicating that the question can be retried. Read the question aloud, then press \textbf{BEGIN}. The players on the second team now have a chance to respond. Depending on the answer, press \textbf{CORRECT} or \textbf{INCORRECT} and \textbf{BEGIN} to lock in the score. The scores are adjusted accordingly. The next question number appears briefly, indicating that the system is ready for the next question. All indicator lights illuminate, and the Scoreboards display the current team scores. Read the next question aloud. Press \textbf{BEGIN} to start the signal-in countdown for the new question.

5. Repeat steps 1–4 until all questions have been asked.

6. After the last question has been played, the Scoreboards briefly flash \textbf{END}. The winning team’s Scoreboard lights green and its score flashes. (See the Game Play Options chapter of the guide for information on what to do if the team scores are tied.)
USING THE QUIZ BOWL SOFTWARE

Install the Software
The Windows version of Quiz Bowl uses an installer to copy the software from the CD-ROM to the right place on your computer. The Macintosh software is a drag and drop installation. The following instructions will walk you through the process of installing the software for your operating system.

Windows Installation
System Requirements
B. Processor: Pentium® 1 GHz (or higher)
C. 

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Minimum Physical RAM Memory</th>
<th>Recommended Available Memory for Quiz Bowl</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista: Basic Edition</td>
<td>512 MB</td>
<td>32 MB</td>
</tr>
<tr>
<td>Windows Vista: Premium, Business or Ultimate Editions</td>
<td>1 GB</td>
<td></td>
</tr>
<tr>
<td>Windows XP</td>
<td>128 MB</td>
<td></td>
</tr>
<tr>
<td>Windows 2000</td>
<td>64 MB</td>
<td></td>
</tr>
</tbody>
</table>
D. Disk Space (min): 50 MB minimum free space on hard drive
E. USB Port: USB 1.1 or 2.0
F. Display Resolution: 1024 x 768 minimum

Installing onto a PC with Windows
1. Insert the Quiz Bowl CD-ROM into the CD-ROM player of your computer. The CD-ROM window will open.
2. Double-click on the Quiz Bowl Setup file. The Quiz Bowl Setup window will be displayed. When you are finished reading the instructions, click on the Next > button.
3. The Select Installation Folder dialog box will be displayed. The installer is configured to install Quiz Bowl in the Windows Program folder and place a shortcut to Quiz Bowl on the desktop. (If you wish to install it in another folder, type in another path name.) Press the Next > button. The Ready to Install dialog box will be displayed.
4. If you are satisfied with the settings displayed, click on the **Install** button. The **Installing Quiz Bowl** dialog box will be displayed.

5. If you wish to cancel the installation, click on the **Cancel** button. If you do not cancel the installation, the **Completing the Quiz Bowl Setup Wizard** dialog box will be displayed.

6. Click on the **Finish** button. Congratulations! You have successfully installed **Quiz Bowl**.

---

**Launching the Program (Windows)**

There are two ways you can launch Quiz Bowl on your computer:

1. A short cut icon labeled **Quiz Bowl** appears on your desktop. Double-click the short cut to start the program. There is also an item labeled Quiz Bowl in your **Start/Programs** menu. Single-click the icon to start the program. The **Quiz Bowl Master** window will be displayed.

   In order to use **Quiz Bowl**, you must agree to the terms of the software license. The software license agreement only appears the first time you launch **Quiz Bowl**. Click on the **Accept** button to accept the terms of the license agreement. The license agreement will close, and the **Quiz Bowl Master** window will appear.

---

**Note**: Please check our website at [www.EducationalInsights.com](http://www.EducationalInsights.com) for the latest upgrades to the Quiz Bowl software and firmware!
Macintosh Installation
System Requirements

A. Operating System: Macintosh OS X (10.3.0 or later)
B. Processor: Power PC (G3 or higher recommended)
C. 

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Minimum Physical RAM Memory</th>
<th>Recommended Available Memory for Quiz Bowl</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macintosh: Tiger 10.4</td>
<td>256 MB</td>
<td>32 MB</td>
</tr>
<tr>
<td>Macintosh: Panther 10.3</td>
<td>128 MB</td>
<td></td>
</tr>
</tbody>
</table>

D. Disk Space (min): 50 MB minimum free space on hard drive
E. USB Port: USB 1.1 or 2.0
F. Display Resolution: 1024 x 768 minimum

Installing and Launching onto a Macintosh with OS X

1. Insert the Quiz Bowl CD-ROM into the CD-ROM player of your computer. The CD-ROM window will open.

2. Locate and double-click on the folder titled Macintosh Quiz Bowl Setup.

   The Macintosh Quiz Bowl Setup window is displayed.

3. Drag the Quiz Bowl folder from the Quiz Bowl Setup window to the Applications folder of your hard drive.

4. Locate the Quiz Bowl folder in the Applications folder on your hard drive and double-click on it to open the folder. Double-click the Quiz Bowl application icon to launch the software. The Quiz Bowl License Agreement is displayed.

   In order to use Quiz Bowl, you must agree to the terms of the software license. The software license agreement only appears the first time you launch Quiz Bowl. Click on the Accept button to accept the terms of the license agreement. The license agreement will close, and the Quiz Bowl Master window will appear.

5. When the software license agreement window closes, the Quiz Bowl Master window will appear, and the Quiz Bowl program icon will appear in the Dock. If you would like the Quiz Bowl icon to remain in the dock, hold down the option key, click on the icon in the dock, and select Keep In Dock.
Create a Game

A. Set Up the Game Play Information

1. If you have not already done so, launch the Quiz Bowl software. (See the Launch Quiz Bowl portion of the Installation section.) The Quiz Bowl Master window is displayed. The Quiz Bowl Master window lets you access all the different features of the Quiz Bowl software.

2. Click on the New Game button. The Quiz Bowl Game Editor window is displayed. The Quiz Bowl Game Editor window lets you create new games or edit existing ones.
3. Type a name for the game in the **Name** field. Because the name of the game will be displayed on the **Master Scoreboard**, it can only be five characters long, including spaces.

4. In the **Signal In Time** field, type the number of seconds players will have to signal in. In a new game, this value will be set to 10. You can type a number between 2 and 500.

5. In the **Warning Time** field, type the number of seconds remaining when the Scoreboard flashes red and green to indicate signal-in time is almost up.
   
   To disable this function enter a zero (0) in the **Warning Time** field. Otherwise, enter a number between 1 and 30.

6. Type the subject name or description of the game in the **Subject** field. This information is necessary if you wish to sort and edit in the future when you have created a large library of games.

**B. Set Up the Teams**

When a game is first created, it has the following default settings for teams:

- There are two teams named Team 1 and Team 2.
- Each team has five player positions.

A position can have up to three students assigned to it so that 15 students can actually play on a team, each with his or her own remote. That is, three students can be registered as Player 1; three can be Player 2; etc. When any one of the three players assigned for example, as Player 1, signals in, the Scoreboard will read “Player 1”. If it helps to prevent confusion, give those three students a ‘sub-team’ name and enter that as Player 1’s name in the software. See “Change a Team’s Player Position Information” under **Edit a Team** on the next page.

- All the teams have a team handicap of zero (0).

---

**Delete a Team**

You may choose to delete a default team in order to have only one team for practice games.

1. Click on the row for any team in the **Teams** subsection of the **Quiz Bowl Game Editor** window. The team is selected.

2. Click the **Delete** button in the **Teams** subsection. A warning dialog box will warn you that the deletion will be permanent. The team will be deleted for that game.
3. Click the **Delete** button if you wish to delete the team, or click the **Cancel** button if you do not want to delete the team. Repeat to delete the other teams.

If you do not wish to delete the default teams but would rather edit the information for each team, do the following.

**Edit a Team**

Use the **Edit** feature to change information about a team.

**Change the Team’s Name**

1. Click on the row for any team in the **Teams** subsection of the **Quiz Bowl Game Editor** window. The team is selected.

2. Click the **Edit** button in the **Teams** subsection. The **Quiz Bowl Team Editor** window is displayed.

3. To change the name of the team, click and drag to highlight the name in the **Quiz Bowl Team Editor** window. Then type the new name.

**Note:** The team names appear on the game printout but not on the Scoreboards.

**Change a Team’s Handicap**

A handicap is the number of points awarded to a team before the game begins. You might give a team a handicap because its members have not been in the class as long as the other team’s members, or you might award a handicap when one team has players that are much younger than the players on the other teams. The purpose of the handicap is to make competition as equal as possible. The maximum number of points that can be entered in the **Handicap** field is 50,000.

1. Press the **Tab** key to move to the **Handicap** field. The handicap will be highlighted.

2. Type a new number.

**Change a Team’s Player Position Information**

The player position names appear in a list in the **Quiz Bowl Team Editor** window. You can change a position name, delete or create a position, and reorder position names.

**Change a position name**

The default names of the five player positions are PLR-1, PLR-2, PLR-3, PLR-4, and PLR-5. Position names can be changed to anything you choose. (Position names are not displayed on the Scoreboards during a game.)

1. Click on the position name you want to change. The name will appear in the **Position Name** field.

2. Click and drag on the entry to select it. Type a new name.

3. Click the **Update** button to accept the new **Player Position Name**. The updated name will appear in the list.
**Note:** In Quiz Bowl a team can have up to five player positions, and each position can have up to three students assigned to it. (All three students may have a **Player Remote**, but those remotes will be registered to only one player position.) When registering the player position for multiple players per position, all players for that position register sequentially when the Master Scoreboard requests registration for that position. Only the name assigned in the game created will appear, so all multiple players per one position will have the same name. Consider assigning a sub-team name, rather than a personal name, to any player position with multiple players.

**Delete a position**

1. Click on a player name in the **Position Names** list to select it.

2. Click on the **Delete** button. A dialog box warns you that the deletion is permanent.

3. Click the **Delete** button to confirm the deletion. The **Position Name** is deleted from the list.

4. Click the **Cancel** button to cancel the deletion.

**Create a position**

If there are fewer than five player positions on a team, you can create a new one. However, if there are already five positions assigned, pressing the **Create** button will display a warning dialog box.

1. Place the cursor in the **Position Name** field. Type a name for the new team.

2. Click on the **Update** button. The new **Position Name** will be added at the end of the list.

**Note:** The names listed in the Position Names list will automatically be reformatted in uppercase because that is how they will appear on the Scoreboards.

**Reorder position names**

1. Select a player position by clicking on it in the **Position Names** list.

2. Press the up or down arrow keys on your computer to move the selected team up or down in the list.

**Add a Team**

You may create a new team for a game. You may have up to three teams per game. If there are already three teams and you try to create a fourth team, a dialog box will warn you that only three teams per game are allowed. If you assign three teams to a game, you will need three Scoreboards. (Refer to the Game Accessories chapter.)

1. Click the **Add** button in the **Teams** subsection of the **Quiz Bowl Game Editor** window.

2. Complete all of the fields as described in the previous section, “Edit a Team.”
Reorder Team Names
You may reorder the teams that appear in the Quiz Bowl Game Editor window.

1. Click on a name in the Team Names list to select it.

2. Press the up or down arrow keys on your computer to move the selected team up or down in the list.

Note: This is how the software will assign the teams to the Scoreboards. A rule of thumb is that if you use only two Scoreboards and you wish to change the team assignments, simply turn off the power on the Host Remote and then move the Signal and Power Cable to the other jack in the back of the Master Scoreboard.

<table>
<thead>
<tr>
<th>Number of Teams</th>
<th>Accessory Scoreboard 1</th>
<th>Master Scoreboard</th>
<th>Accessory Scoreboard 2 (sold separately)</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-TM1-</td>
<td></td>
<td></td>
<td>No Scoreboards connected</td>
</tr>
<tr>
<td>2</td>
<td>-TM1-</td>
<td>-TM2-</td>
<td></td>
<td>Scoreboard 2 not connected (and the Signal and Power Cable is plugged into the jack as shown in the “Connect The Components” section of the Playing a Game chapter.)</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>-TM1-</td>
<td>-TM2-</td>
<td>Scoreboard 1 not connected</td>
</tr>
<tr>
<td>3</td>
<td>-TM1-</td>
<td>-TM2-</td>
<td>-TM3-</td>
<td>All Scoreboards connected If three Scoreboards are connected and a two-player game is chosen, Accessory Scoreboard 1 is used.</td>
</tr>
</tbody>
</table>

C. Game Questions
Game questions are created in the Quiz Bowl Question Editor. The Quiz Bowl Question Editor is accessed from the Quiz Bowl Game Editor window.

Access the Question Editor for a New Game
When you first launch the Quiz Bowl software, the Quiz Bowl Master window is displayed.

Create Questions

1. Click on the New game button. A blank Quiz Bowl Game Editor window is displayed.

2. Type a name and subject for the game.

3. Click on the Add button on the Quiz Bowl Game Editor window. The Quiz Bowl Question Editor window is displayed. The number of the question based on its position in the list is already entered at the top of the window.
3. Click on the **Question Type** drop-down menu. There are two types of questions in Quiz Bowl.

   - **Single Play Question** - A **Single Play** question is a question that reveals the correct answer when answered incorrectly. A true or false question is an example of a single-play question.

   - **Retry Question** - Most questions will probably be of this type. A **Retry Question** allows another team to signal in and answer the question if the first team to signal in answers incorrectly.

4. Select either **Retry** or **Single Play** from the **Question Type** drop-down menu.

5. Press the **Tab** key to advance to the **Answer Time** field.

6. Type a number from 1 to 60. This is the amount of time that the players will have to answer the question after signaling in.

7. Press the **Tab** key to advance to the **Points** field. Enter a number from 1 to 1,000. If the team answers correctly, this amount will be added to the team’s Scoreboard (or subtracted if answered incorrectly).

8. Press the **Tab** key to advance to the **Subject** field. This information is necessary if you wish to sort and edit in the future when you have a large library of questions.

9. Click on the **Bonus or Tie Breaker** checkbox to define how this question will be used. A **Bonus or Tie Breaker** question will ONLY appear if the host holds down the Question Key for 2 seconds during the game. A **Bonus Question** allows a team to add additional points to the score beyond those that can be earned during regular game play. A **Tie Breaker Question** is used to break a tie if the score is tied at the end of a game.

   If this is a regular game question, then leave the **Bonus** or **Tie Breaker** box unchecked.

10. Click anywhere inside the **Question** field. Enter a question.

11. Press the **Tab** key or click in the **Answer** field.

12. Enter the correct answer.

13. Click on the **Save and Continue** button if you want to add more questions. A blank **Quiz Bowl Question Editor** window will be displayed.

14. Click on the **Save and End** button if you are finished entering questions. You will then be returned to the **Quiz Bowl Game Editor** window. Questions are listed in the **Quiz Bowl Game Editor** with the details you entered displayed in columns.

**Edit Questions**

Access the **Quiz Bowl Game Editor** for an Existing Game

Use the **Quiz Bowl Game Editor** to edit questions in existing games.

1. Click on an existing game in the **Quiz Bowl Master** window.

2. Click on the **Edit Game** button. The **Quiz Bowl Game Editor** window for that game is displayed.

3. Click on a question in the **Questions** list to select it.

4. Click on the **Edit** button in the Questions list. The **Quiz Bowl Question Editor** window is displayed with the selected question’s information. (You can also double click on a question to open it in the **Quiz Bowl Question Editor**.)
5. Edit the question. When you are finished, do one of the following:
   - Click **Save and Continue** to edit another question in the game. The next question will be displayed. Click on **Save and Continue** to cycle through the game’s questions.
   - Click **Save and End** to save the question and close the Question Editor window.
   - Click **Cancel** if you wish to cancel the edit and discard your changes.

**Delete Questions**
1. Click on a question in the Questions list to select it.
2. Click on the **Delete Question** button. A dialog box will warn you that the question will be permanently deleted.
3. Click on the **Delete** button of the dialog box to permanently delete the question.
4. Click on the **Cancel** button to return to the Quiz Bowl Game Editor without deleting the selected question.

**Rearrange Questions**
1. Click on a question to select it.
2. Press the up or down arrow key on your keyboard to move the selected question up or down in the list.

**The Question Bank**
Questions that are created for any game are automatically stored in a database called the Question Bank. Questions stored in the Question Bank can be used in multiple games.

**Access the Question Bank**
There are two ways to access the Question Bank.

- Click on the **Open** button in the Question Bank section of the Quiz Bowl Master window. The Quiz Bowl Question Bank window is displayed.
- Click on the **Question Bank** button of the Quiz Bowl Game Editor window. The Quiz Bowl Question Bank window is displayed.

**Working with Questions in the Question Bank**
You can add, delete, and duplicate questions in the Question Bank. You can copy questions from the Question Bank into games as well as import questions from games into the Question Bank. You can also print the Question Bank for your records.
Add a Question
When you first open the Question Bank window, the question fields are empty.

1. Complete the required fields of the Quiz Bowl Question Bank window. When you are finished entering the question, click the Save button. The question will be added to the Question Bank.

2. Click the Add button to add another question or click the Close button to close the Question Bank window.

Delete a Question
1. Select a question in the Question Bank window.

2. Click the Delete button. A dialog box warns you that the deletion is permanent. Click Delete. The question is deleted.

Duplicate a Question
You might want to duplicate a question so you can use part of it to write a new one.

1. Select a question in the Question Bank question list. The question data is displayed in the Question Bank fields at the top of the screen.

2. Click the Duplicate button. The duplicated question is added to the end of the Question Bank question list and is selected.

3. Edit the question in the fields at the top of the screen.

4. Click the Save button to save the question, or click the Add button to clear the question fields and add a new question.

Add Questions to a Game from the Question Bank
1. Open the Quiz Bowl Question Bank window. The Quiz Bowl Question Bank window is displayed.

2. Click on the checked boxes in the Copy column to select the questions you would like to copy.

3. Select the game to which you would like to copy the questions in the drop-down menu to the right of the Copy to Game button.

   Note: A new game will not appear in this drop-down menu until you have saved it.

4. Click on the Copy to Game button. The questions will be copied to the selected game.

Copy Questions from the Question Bank
1. Select and open a game in the Quiz Bowl Master window.

2. Click on the Quiz Bowl Question Bank button of the Quiz Bowl Game Editor window. The Quiz Bowl Question Bank window is displayed.

3. Move the windows on your screen so you can see both sets of questions at the same time.
4. Click and drag questions from the questions list of the Quiz Bowl Question Bank into the Quiz Bowl Game Editor.

Export or Import Games and Questions

You can export and import games and questions in order to share them with other teachers. Quiz Bowl exports games and question banks to the XML file format. The XML file format allows software programs to share information. Open the Quiz Bowl Master window to import or export games and questions.

Questions and answers can also be written in a text editor and saved as TXT files. (A TXT file format is a simple text file.) The questions and answers can then be imported into the Question Bank.

Export a Quiz Bowl Game to an XML File

1. Select File ➪ Export ➪ Game from the menu bar. A save dialog box is displayed.

2. Type a name for the game. Then navigate to the folder in which you wish to save the game.

3. Click the Save button. The game will be saved in XML format.

Export a Quiz Bowl Question Bank to an XML File

1. Select File ➪ Export ➪ Question Bank from the menu bar. A save dialog box is displayed.
2. Type a name for the **Question Bank** file. Then navigate to the folder in which you wish to save it.

3. Click the **Save** button. The **Question Bank** file will be saved in XML format

**Import an XML Game File into Quiz Bowl**

1. Select **File** ➤ **Import** ➤ **Game**. An open dialog box is displayed. Navigate to the folder containing the XML game file you wish to import. Click on the file to select it.

2. Click the **Open** button. A dialog box will ask if you also want to import the game into Quiz Bowl.

3. Click either **Yes** or **No** to proceed. If you select **Yes**, the game will be added to Quiz Bowl.

**Import an XML or TXT Question File to the Quiz Bowl Question Bank**

1. Select **File** ➤ **Import** ➤ **Question Bank**. An open dialog box is displayed. Navigate to the folder containing the XML file you wish to import. Click on the file to select it.

2. Click the **Open** button. The questions will be imported into the **Question Bank**.

**Write Questions and Answers and Save Them as a TXT File.**

You can also write questions and answers in any program that saves plain text files in the TXT format. Then you can import them into the **Question Bank**. NotePad on Windows and TextEdit on Macintosh will save files in TXT format.

1. Launch your text editor program (NotePad or Text Edit) and open a new document.

2. Write questions in the following question-and-answer format:

   **Question:** What are the first 5 letters of the alphabet?

   **Answer:** ABCDE

   **Note:** There needs to be a blank line between each question-answer pair.

3. When you have finished writing your questions and answers, save the document as a text file.

**Import a TXT Question and Answer File into the Quiz Bowl Question Bank**

1. Select **File** ➤ **Import** ➤ **Question Bank**. An open dialog box is displayed. Navigate to the folder containing the TXT file you wish to import. Click on the file to select it.

2. Click the **Open** button. The questions will be imported into the **Question Bank**.
Print a Game
When you are ready to play Quiz Bowl, print the game so that you can read each question aloud and see the answer as well as the question details such as the number of points the question is worth, answer time, etc. You may choose to print copies without answers to give students a copy to read along during the game. Choose the Save to RTF option if you wish to make your own editing changes to the print out.

1. Click on a game in the Quiz Bowl Master window to select it.

2. Click on the Print button or select File ➤ Print Game from the Menu Bar at the top of the Quiz Bowl Master window. The Quiz Bowl Print Game window is displayed. All of the information about the game is included on this printed document for use by the host during game play.

3. Press the small up or down arrow keys in the upper right-hand corner to scroll through the pages of the game. Questions and answers for the game begin on page 2 of the Quiz Bowl Print Game window.

4. Click on the Print button to print the game on your printer. The default is to print a game with answers. Click to uncheck the Print Answers box if you want to print the game without the answers.

5. Click on the Cancel button to close the Quiz Bowl Print Game window. The Quiz Bowl Master window is displayed.

6. If you think any changes should be made to the game before it is printed, click on the Open Game button to open the Quiz Bowl Game Editor for the game. The Quiz Bowl Print Game window will be dismissed and the Quiz Bowl Game Editor for that game will be redisplayed.

Download Games to the Master Scoreboard
Your Quiz Bowl games must be downloaded to the Master Scoreboard of the Quiz Bowl System before you can hold a Quiz Bowl competition with your games. (The exception is that you can play the 10- and 20-question Instant Quiz games without downloading because those are pre-programmed into the Master Scoreboard.) Download your games from the Quiz Bowl Master window.

1. Click on the checkboxes in the Download column of the Quiz Bowl Master window to select the games you want to download. You may check off individual games, or you may click on Check All to choose all the games. (Click on Uncheck All to deselect the games.)

   Want to download multiple copies of the same game? Open the Quiz Bowl Game Editor for the game you wish to duplicate. Click in the Name field and change the game name. Then click on the Save As button. Your game will be duplicated and given the new name.

2. Connect power to the Master Scoreboard. Connect the USB cable to your computer port. ‘-US3-‘ will appear on the Master Scoreboard.
Note: It is not necessary that the Accessory Scoreboard be connected to the Master Scoreboard during the downloading process (although it will not harm the system if it is).

3. Download the games by clicking on the Download Now button. A dialog box will inform you of what has been downloaded. Click OK.

4. Disconnect the USB cable from your computer and the Master Scoreboard.

Note: The USB cable can be plugged in and unplugged at anytime without harming the Master Scoreboard or your computer.

Quit or Exit the Quiz Bowl Software
1. Click on the Close box of the Quiz Bowl Master window to close it and exit the Quiz Bowl software if you are running it under Windows.

2. Select Quiz Bowl ► Quit from the Menu Bar to quit the software if you are running it under Macintosh OS X.

Update the Quiz Bowl Master Scoreboard’s Firmware
Occasionally it may be necessary to update the Quiz Bowl Master Scoreboard’s firmware. You will always be able to find the latest update files on the Educational Insights’ Quiz Bowl web site.

1. Connect the Master Scoreboard to your computer using the USB cable.

2. Select Tools ► Update Firmware from the Menu Bar. The Quiz Bowl Firmware Upgrade window will be displayed.

3. Click on the Choose button of the Quiz Bowl Firmware Upgrade window.

4. Navigate to the firmware upgrade, click on it, and then click OPEN to put the new firmware in the Choose field.

5. Follow the steps on screen to complete the firmware upgrade.
PLAYING A GAME

Connect the Components

1. Connect power to the Master Scoreboard. The firmware version will be briefly displayed.

If two Scoreboards are used, then the Master Scoreboard will be assigned Team 1 if the Signal and Power Cable is plugged into this jack. It will be Team 2 if plugged into the jack as shown. It works either way. (If you purchased a third Scoreboard, then plug the additional Signal and Power Cable into this jack.)

2. Connect the Accessory Scoreboard to the Master Scoreboard using the Signal and Power Cable.

Note: Please check our website at www.EducationalInsights.com for the latest upgrades to the Master Scoreboard firmware and the Quiz Bowl software.
Become Familiar with the Host Remote Control

The Host Remote Control is used to control the Quiz Bowl System during game play. Following is a brief description of the functions of the eight keys available on the Host Remote:

### POWER
- Press the **POWER** key to turn the Quiz Bowl System on and off. If the system is off, a momentary press turns it on. If the system is on, press the **POWER** key for 2 seconds to turn it off.

### BEGIN
- When you are in game selection mode, press the **BEGIN** key to select the game whose game ID is displayed on the Master Scoreboard.
- Press the **BEGIN** button to signal the start of a question period during game play.
- Press **BEGIN** to lock in a score after you press **CORRECT** or **INCORRECT**.
- Press **BEGIN** for 2 seconds during game play if you want to select a different game. This will return the Quiz Bowl System to game selection mode.

### UP
- Press the **UP** arrow key during game selection, player registration, question selection, or volume adjustment modes to move through a list of selectable items.

### DOWN
- Press the **DOWN** arrow key during game selection, player registration, question selection, or volume adjustment modes to move through a list of selectable items.

### CORRECT
- Press the **CORRECT** key if a player answers a question correctly.
- Press the **CORRECT** key during player registration if a player has registered incorrectly. This will clear the incorrect player registration and allow a new registration.
- Press and hold the **CORRECT** key for 2 seconds to generate the volume setting display. Then adjust the loudspeaker volume using the UP and DOWN arrow keys.

### INCORRECT
Press the **INCORRECT** key if a player answers a question incorrectly.
**QUESTION**
- Press the **QUESTION** key during game play to select a different question from the one displayed.
- Press the **QUESTION** key for 2 seconds to access bonus questions during a game or if there is a tie at the end of a game. The first bonus question will be displayed. Bonus questions are used as tie breakers. (The host can also resolve a tie by playing a new game.)

**SCORE**
- Press the **SCORE** key to display the current scores. This can be done anytime during a game except during timed events such as countdowns or when waiting for a player to answer after signaling in.
- Press and hold the **SCORE** key for 2 seconds between questions to return to player registration mode and check the Player Remotes.

---

**Power up the Quiz Bowl System**
Press the **POWER** key on the **Host Remote Control**. The **Master Scoreboard** displays the word **HELLO** for 2 seconds and simultaneously determines the number of connected **Accessory Scoreboards** and verifies the content of the **Master Scoreboard’s** memory. It then scans the games in its memory to find the first unplayed game.

---

**Select a Game**
1. Press the **UP** and **DOWN** keys to move through the available games. (The Accessory Scoreboard is blank during this step.)
2. Press the **BEGIN** key to select the desired game.

   (If **Mn5** appears on the **Master Scoreboard**, it means that there are not enough Scoreboards for the number of teams assigned to the game. The letter **n** refers to the number of missing Scoreboards. Press the **BEGIN** key to ignore the warning and continue with the selected game. The game will automatically be reconfigured to match the number of attached Scoreboards. See the Troubleshooting section for more information.)
Register the Players

Player registration allows the Master Scoreboard to recognize which Player Remote signaled in to answer a question during game play and to assign scores accordingly.

1. Press the BEGIN key once a game has been chosen for play. The team numbers will be displayed on the available Scoreboards as `-TM#, where # represents the number of the team. One Scoreboard is TM1 and the other Scoreboard is TM2. (If a third Scoreboard is added, it will be named TM3.)

2. Press the BEGIN key to begin player registration. A Scoreboard flashes the ID of the first player position on Team 1.

3. Instruct all the students assigned to the first player position on Team 1 to press the buttons on their Player Remotes. If registration is successful, the indicator light on the Scoreboard flashes green and the Scoreboard beeps. (See the “Return to Player Registration” section of the Game Play Options chapter if player registration is not successful.)

4. Press the DOWN key to move registration to the second player position on Team 1, and follow the same procedure described above. Repeat the process for all of the player positions on Team 1.

5. Press the DOWN key after the last player on Team 1 has registered. The other Scoreboard will flash the ID of the first player on Team 2. Repeat steps 3 and 4 to register the players for Team 2.

6. When you are finished registering players, press BEGIN. If you registered fewer than the pre-programmed number of players, the Scoreboards flash `CHECK` (check) to double check that you are finished with registration. If you are NOT finished with registration, press the UP or DOWN keys to cycle through and enter additional players.
Play the Game

Game play begins with the Scoreboards briefly displaying -001-, the ID for the first question. The question ID is replaced with the starting score for each team and the indicator lights red. The scores will normally be 0 unless a team was assigned a nonzero handicap during game creation.

1. Read the first question aloud.

2. Press the BEGIN key. The Scoreboards begin the countdown for the Signal-In Time, and the indicator lights blink green. When the countdown reaches the Warning Time, the indicator lights alternately flash red and green. Players can signal in any time during the Signal-In Time.

3. **If no player signals in within the Signal-In Time**
   All Scoreboard indicator lights flash red, and the question is passed over. The next question number appears briefly; then the current scores are displayed. The system is ready for you to read the next question aloud.

4. **If one or more players signal in within the Signal-In Time**
   The Quiz Bowl System recognizes only the first Player Remote to signal in. The Scoreboard for the corresponding team displays that player’s ID and its indicator light turns green. Others who signal in after the first player will see their lights turn red. It remains green for the period of time the player has to answer the question. At the end of this period, the light flashes red. The teacher may extend the answer period to give the player more time to respond.

5. **If the player responds correctly**
   Press CORRECT on the Host Remote. The light on the player’s Scoreboard flashes green, and his or her team’s score is adjusted. Press BEGIN to lock in that player’s score. The next question number is briefly displayed. The system is ready for the next question when the indicator lights illuminate and all current scores are displayed.
If the player responds incorrectly
Press **INCORRECT** on the **Host Remote**. The light on the player’s Scoreboard turns red, and the value of the question is subtracted from the team’s score. Press **BEGIN** to lock in that player’s score. The light turns off and the player’s Scoreboard displays the adjusted score. Then one of two things happen:

a. If the question is a **Retry** question, the player’s Scoreboard becomes inactive. The light on the other Scoreboard illuminates, indicating that the question can be retried. Read the question aloud, then press **BEGIN**. The players on the second team now have a chance to respond. Depending on the answer, press **CORRECT** or **INCORRECT** and then press **BEGIN** to lock in the score. The scores are adjusted accordingly. The next question number appears briefly, indicating that the system is ready for the next question. All indicator lights turn red, and the Scoreboards display the current team scores.

b. If the question is a **Single-play** question (such as true/false), the next question number appears briefly and the system advances to the next question. All Scoreboard lights illuminate, and they display the current team scores.

5. Repeat steps 1–4 until all questions have been asked.

**Accidentally pressed the wrong CORRECT/INCORRECT button?** The score does not lock in until you press **BEGIN**. So, you can press the other **CORRECT/INCORRECT** button (as many times as you like!) and the Scoreboard will recalculate the correct score. Once you press **BEGIN** and move on to the next question, the score for the previous question is locked in and cannot be changed.

**What if no one knows the answer and you don’t want to wait for the signal-in time to run out?** If you have programmed in a long signal-in time and it becomes clear that no one will be able to answer the question (no one is going to signal in), simply press **BEGIN** to move on to the next question. There will be no score changes.

6. After the last question has been played, the Scoreboards briefly flash **END**. The winning team’s Scoreboard lights green and its score flashes. (See the Game Play Options chapter of the guide for information on what to do if the team scores are tied.)
GAME PLAY OPTIONS

During game play the host has several options.

Selecting a New Game
You can change to a new game at any time during a game.

1. Press and hold the BEGIN key for 2 seconds to return to game selection mode. The game that was in progress is immediately terminated. (If a question was in progress, scoring for that question is lost.)
2. Press the arrow keys to see the available games.
3. Press BEGIN to select a game.
4. Re-register players for the new game. (See “Register the Players” in the Playing a Game chapter.)

Selecting Questions
As you look at the printout of a game, you may decide that you want to skip a question or play a question out of order. You can do so without editing and downloading the game again. The following instructions explain how to select questions out of order during game play.

1. Press the QUESTION key briefly. The Master Scoreboard will display ~nnn~ where nnn is the next question number. The Accessory Scoreboard(s) will become blank.
2. Press the UP and DOWN arrow keys to select questions. Only unplayed question numbers will appear.
3. When the desired question number is displayed press the BEGIN key to return to game play.

Selecting a Bonus or Tie-Breaker Question
Press the QUESTION key for 2 seconds to select bonus questions. The Master Scoreboard will display ~nnn~ where nnn is the next bonus question. The Accessory Scoreboard(s) will become blank. Bonus questions are available anytime during a game as long as the last regular question has not been played. If there is a clear winner after the last regular question is played, the game ends.

If, however, a game ends in a tie, bonus questions are available for use as tie-breaker questions.

Note: The unit will not respond to the press of the QUESTION key if there are no questions remaining.
Display Scores
Press the **SCORE** key to compare the current team scores. You will see one of the following:

- The display on the Scoreboard of the team with the highest score will flash. If the score is greater than 0, its indicator light will flash green. Otherwise the indicator light will be off. The scores for the other teams will display without flashing and their indicator lights will be off.

- If two or more teams have the same high score, both of their displays will flash. If their scores are greater than 0, their indicator lights will flash green. Otherwise their indicator lights will remain off. The score for the remaining team (if any) will not flash and its indicator light will remain off.

Press the **SCORE** key again to end the comparative score display mode and return to game play mode.

*Note:* The **SCORE** key does not work during timed events such as countdowns or when waiting for a player to answer after signaling in.

Return to Player Registration
Press and hold the **SCORE** button for 2 seconds between questions to return to player registration mode to check that players have registered their remotes properly and to correct the registrations if they haven’t.

Follow the steps below for both of these procedures. Then press the **BEGIN** button when you are done to return to game play mode.

Review Registrations
Press the **UP** or **DOWN** arrow while in registration mode to select a team position. Then ask each player assigned to that position to press the button on his or her **Player Remote**. One of three things will happen:

- If the player is assigned, the indicator will flash green once without a beep.

- If the player is not assigned and the team position has fewer than three assigned students, the student will be assigned. The indicator light will flash green once, and the Scoreboard will beep.

- If a student tries to register after the position already has three students assigned to it, the indicator will flash red once without a beep. If that student is already assigned to another position, the button press is ignored.

Correct Player Registrations
Press the **UP** or **DOWN** key to select a player position while in registration mode. Then press the **CORRECT** key to correct or make changes to the current registration. The **Master Scoreboard** will respond by beeping once and flashing a yellow indicator light once. This action clears the registration for the selected player position, allowing all students who are assigned to that position to re-register.
• If the problem is that one or more players have registered for the wrong team, the host must clear the registration for the affected players before re-registering them.

**Adjust the Volume**

1. Press the **CORRECT** key for 2 seconds to adjust the loudspeaker volume. *Note, however, that Volume Adjustment is not permitted during registration, player selection, or player answer modes.* All indicator lights will go off, the Accessory Scoreboards will become blank, and the **Master Scoreboard** will display `/gid32/gid22/gid14/nn` where `nn` is the current volume setting of 1, 2, or 3 for low, medium, or high, respectively.

2. Press the **UP** or **DOWN** arrow keys to change the volume setting. After each press, the **Master Scoreboard** emits a beep at the new volume setting.

3. Press the **BEGIN** or **CORRECT** key for 2 seconds to exit the volume adjustment mode.
TIPS FOR HOSTS

A host’s role includes making sure that Quiz Bowl moves along smoothly. Here are some tips that will help make you a pro at hosting a game.

Instructing Players About the Signal-in Countdown
Before a game begins, make sure the players understand the importance of the signal-in countdown display on the Scoreboards. Remind them that the alternating green and red indicator light shows that they are about to run out of signal-in time. Also, caution students to wait until you press BEGIN before signaling in to answer a question.

Giving Players More Time to Respond
Do you want to give players more time to respond to questions? You may do so without affecting game play. After a player has signaled in and the answer time limit has passed, simply ignore the red light on the player’s Scoreboard and wait before pressing Correct or Incorrect on the Host Remote.

Completing a Game on a Different Day
You can begin a Quiz Bowl game on one day and then continue it the next day. Just hold down the POWER key on the Host Remote to shut down the Master Scoreboard, and the program will save the scores. The player registration information, however, will not be saved.

To continue a previously halted game, follow these directions:

1. Power up the Quiz Bowl System.
2. Select the game you discontinued.
3. Register the players who will continue the game.
4. Press the BEGIN button on the Host Remote to restart the game. The first unanswered question number for the game will be displayed briefly. Then the team scores will be displayed.
5. Read the questions aloud. Press the BEGIN button to start the signal-in countdown.
Incorporate Other Media
Augment the spoken question clue with a photograph, illustration, or recorded sound.

Possible categories include: Animal Sounds, Name That Tune, Artists and Their Work, Who Is It?, Reading Graphs and Charts, and Reading Maps. A few sample media and clues are listed here.

• Play a recording of an owl to go with the question “What animal hoots at night?”
• Show a picture of a painting to go with the question “Who is the artist who created this painting?”
• Play a recording of “The Star-Spangled Banner” to go with the question “What is the name of this melody?”
• Show a graph to go with the question “Based on this graph, what is the percentage of students in our class who have cats?”
• Show pictures of triangles of different proportions and ask, “These shapes are examples of what polygon?”
• Show a photograph of Winston Churchill and ask, “What is the name of this British leader?”

Add Some Action
Spice up your games with “action” categories that challenge students to do something. Whether they’re serious or silly, these tasks are a great way to engage kinesthetic learners. For these types of challenges, eliminate the time limit.

• Sing the “Alphabet Song.”
• Point to your cervical vertebrae.
• Draw a parallelogram on the whiteboard.
• Measure the length of a shelf.
• Spell your name in sign language.
• Make the sound an elephant makes.
• Point to Morocco on the world map.
• Show “23” with the Unifix blocks.
• Balance a pencil on your nose for 5 seconds.

Challenge Students to Use Higher-Thinking Skills
If you plan to be the game host, you can include clues that require a creative response. Questions that are somewhat open-ended can provide variety and substance without compromising the game’s fairness. For example, you might ask these questions:

“What is one factor that contributed to the extinction of the dodo bird?”

“Who played an important role in the civil rights movement?”

You may even wish to require that students follow their answers with a brief explanation. Be sure to make your expectations clear before students begin answering.
USING QUIZ BOWL IN THE CLASSROOM

Quiz Bowl is a great way to reinforce curriculum during class time. It is a valuable educational tool in other situations as well. Here are some ideas for using Quiz Bowl with students.

Integrating Quiz Bowl with Your Curriculum

• Finish a unit of study with a game that reinforces what students have learned.
• Create a game for students to play at the beginning of the school year to review skills and knowledge that may be “rusty” after the long break.
• Play a game every Friday afternoon based on what you’ve studied that week.
• During the weeks leading up to standardized tests, use Quiz Bowl as a fun way to review concepts on which students are likely to be tested.
• Finish each semester with a “semester review” game.
• Play Quiz Bowl on rainy days during recess or lunch.
• Break students into teams and assign each to write questions and answers for a Quiz Bowl game based on something the class is studying. Depending on their capabilities, allow them to act as hosts as the rest of the class plays their game.

This is one of the most powerful ways to use Quiz Bowl. In order to write good questions and answers, students must thoroughly review the material you have taught because when they host the game they must judge whether or not answers given by their classmates are correct. The requirement to be good judges as well as hosts is a powerful motivation to learn and understand the material for which they are writing questions.

• List topics for a Quiz Bowl game on the board, and ask each student to write two or three appropriate questions. Create a game using their questions.

Competitions

Quiz Bowl stimulates friendly competition and motivates students to learn. Competitions can be between teams in your classroom, or they can involve one or more teams from other classrooms. Competitions might include

• Tournaments
• School-wide competitions
• Games between classes
• District-wide competitions

Family Events

Quiz Bowl is a great way to showcase students’ abilities at school events where families are in attendance. Or, get parents acquainted with school or classroom procedures by challenging them to a round of Quiz Bowl.

• Back-to-School Night
• PTA Meetings
• Open House
• Science Fair

Ways to Play That Get the Whole Class Involved

Like the College Bowl competitions after which Quiz Bowl is modeled, Quiz Bowl is set up for two teams. One way to involve more students is to buy additional wireless remotes or a third Scoreboard. (See the “Game Accessories Section.”) Games can be set up to accommodate up to 45 players!

However, you don’t need extra equipment to make the game worthwhile and fun for your students. There are plenty of fun ways to play Quiz Bowl in a classroom of 30 or more students.
TV Style
Have fewer students play while the rest of the class acts as a “studio audience.” The next time you play, you can either choose different contestants or have the returning winning team—the winner of the first game—take on a new challenger team.

Team Spirit
Divide your class into several Quiz Bowl teams to be used every time you play. For each game, have different teams play while those not playing cheer them on. You might want to encourage team spirit by allowing students to choose team names, mascots, and colors.

Pass the Remote
Choose a player on each team to begin. After each response, the remote is passed to the next player on the team.

The Hot Seat
Choose a player on each team to begin. If a player gets a correct response, he or she gets a chance to signal in on the next item. Otherwise, the player passes the remote to the next player on the team.

After-School Tournament
Quiz Bowl is a perfect after-school activity. You will be surprised by the enthusiasm friendly competition can inspire. Try allowing students to sign up for a weekly game. A format in which the winning team of the previous game takes on a new challenger team can be especially motivating. Students will be eager for a chance to unseat the returning champion!

Student-Created Games
Invite individual students or groups of students to write their own Quiz Bowl games. Create a printed template on which students can write questions and answers. This class-time or homework project is a great way to reinforce content from class. Once they have completed their games, you will have to input the games using the Quiz Bowl software. If you have a computer in your classroom that students can use, have them input the game themselves.

Following are a few suggestions on how you can organize this activity.

• Make the activity either a class-time or homework project.

• If you have a classroom computer that students are allowed to use, have the students type their clues directly into a game template in Quiz Bowl Question Editor.

• Define the content you want the students to cover. You may refer them to a chapter in one of their textbooks, to a syllabus for the class, or to some supplementary material you want to provide.

• Review student games before they are played. Obviously you must check for accuracy, but check also for the mischievous clues students are often tempted to include. Depending on their content, you may decide to allow one or two for the fun they add to the game.

• When it is time to play, let the team who has written the game choose who will be the host and who will be the judges that decide whether responses are correct or not. Students should play host only if you have taken the time to train them to do so. An untrained host will cause unnecessary delays and confusion.
• A Quiz Bowl game is generally more effective if the teacher selects the players for the game. This ensures that everyone gets a chance to participate in the review of the content. It’s even more effective if you have multiple wireless player remotes allowing teams of players rather than individuals to compete. If you prefer, the players’ names can also be “drawn from a hat” before the game begins, ensuring a random selection of players.

• While you watch the game being played, take the opportunity to make notes about which clues reveal a lack of knowledge or understanding. Review the material covered in the game after it is over. Quiz Bowl helps you to know how well your students have learned the material you have taught.
GAME ACCESSORIES

Quiz Bowl has been engineered to provide teachers with ease of operation and to allow opportunities for expansion. Below is a list of optional game accessories you can purchase to expand the program’s capabilities.

Your Quiz Bowl System comes with a Master Scoreboard, an Accessory Scoreboard, a Host Remote, and ten Player Remotes. Each Scoreboard displays scores for one team. To accommodate a third team, you can add one more Accessory Scoreboard Unit. This unit comes with five additional Player Remotes and other items.

**EI-8496 Accessory Scoreboard Unit — Extra Team Set**
1 Accessory Scoreboard  
5 Player Remote Controls  
1 Signal and Power Cable  
1 Erasable Marker  
1 Erasable Name Card

Additional player remotes are available for purchase in packs of five.

**EI-8497 Quiz Bowl Five-Pack Player Remote**  
5 Quiz Bowl Player Remotes
TRoubleshooting

Every effort has been made to make Quiz Bowl a comprehensive, yet easy-to-use, system. If you experience a problem, read this section first for a possible solution. If you require additional help or information, please contact Customer Service.

Problem: The Host Remote does not work during a game.

Possible Solutions:
• Check that the Master Scoreboard’s power adapter is connected to a working electrical outlet.
• Check the batteries in the Host Remote.
  1. Unscrew the door to the battery compartment. Then check to see that the batteries have been placed in the correct positions.
  2. This unit may have experienced RF interference; remove the batteries and re-install them.
  3. Replace the batteries with fresh ones.
• Score key doesn’t appear to be working? Try again after completing a timed event (see note on page 34).

Problem: A Player Remote does not register with the Master Scoreboard, or it does not work during a game.

Possible Solutions:
• Ask the student if he/she is waiting until you press BEGIN on the Host Remote before attempting to signal in. If a student tries to signal in before BEGIN is pressed, the Player Remote may be locked out. See box on page 31.
• Unscrew the door to the battery compartment. Check that the batteries have been inserted correctly.
• Replace the batteries with fresh ones.
• Check that the Player Remote was actually registered properly. To do so, follow the directions in the “Return to Player Registration” section of the Game Play Options chapter.
• This unit may have experienced RF interference; remove the batteries and re-install them.

Problem: The Master Scoreboard displays MnS.

Possible Solutions:
The display MnS appears when a game requires more Accessory Scoreboards than are actually connected to the Master Scoreboard. The \( n \) refers to the number of missing Scoreboards. Do one of the following to clear the display:
• Press the BEGIN key to ignore the warning and continue with the selected game. The game will automatically be reconfigured to match the number of attached Scoreboards. Please note that if you press BEGIN to ignore the warning, then during Player Remote registration, the Scoreboards may go blank. To solve this problem, continue to press the UP or DOWN arrow key on the Host Remote until a proper registration display appears.
Troubleshooting

- Press the **POWER** key for 2 seconds to turn the power off.
  1. Disconnect the power from the **Master Scoreboard**.
  2. Connect the required number of **Accessory Scoreboards**.
  3. Reconnect power to the **Master Scoreboard**, and wait for the firmware version number to disappear.
  4. Press the **POWER** key on the **Host Remote Control**. The **Master Scoreboard** will return to Game Selection Mode. Select a game as described in the Playing a Game chapter.

**Problem:** *The Master Scoreboard displays NGM.*

**Possible Solution:**
The display ***NGM*** indicates that all games stored in the **Master Scoreboard** have been played. Follow these steps to download unplayed games:

1. Connect the **Master Scoreboard** to your Windows PC or Macintosh computer using the **USB** cable.
2. Launch the Quiz Bowl software, select one or more games, and download them to the **Master Scoreboard**. (See the Using the Quiz Bowl Software chapter for information on downloading games.)

**Problem:** *The Master Scoreboard displays an error code Enn, and the indicator light flashes yellow.*

**Possible Solution:**
The Quiz Bowl system checks for corrupted games in its memory at two times – first when the power adapter is connected to the **Master Scoreboard**, and second when the **POWER** key on the **Host Remote** is pressed. If a corrupted game is encountered, the **Master Scoreboard** displays an error code in the form *Enn*, where *nn* is an error code, and the indicator light flashes yellow. The only solution to this type of error is to download unplayed games to the **Master Scoreboard** again. If an attempt to download unplayed games to the **Master Scoreboard** fails to clear the error code, call Educational Insights customer service department at (800) 995-4436.

1. Connect the **USB** cable from your Windows PC or Macintosh computer.
2. Launch the Quiz Bowl software, select one or more games, and download them to the **Master Scoreboard**. Refer to the Using the Quiz Bowl Software chapter for information on downloading games.

**Problem:** *A Master Scoreboard in an adjacent classroom experiences interference from your Host Remote or vice versa.*

**Possible Solutions:**
Follow these instructions to reduce the sensitivity of the affected **Master Scoreboard** to receive a signal from a **Host Remote**.

1. Connect the affected **Master Scoreboard** to a computer using the **USB** cable.
2. Launch the Quiz Bowl software and select **Tools** ▶ **Scoreboard Preferences** from the **Menu Bar**. The **Quiz Bowl Scoreboard Preferences** window will be displayed.
3. Click the button of the Sensitivity slider. Then click to the left to reduce or to the right to increase the distance from which the Master Scoreboard can sense the Host Remote.

4. Test for interference on the affected Master Scoreboard by pressing the POWER button on a Host Remote while you are in the adjacent classroom.

Problem: A Master Scoreboard’s sound effects are too loud or too soft for the game play setting.

Possible Solutions:
Follow these instructions to reduce or increase the volume of a Master Scoreboard’s sound effects.

1. Connect the Master Scoreboard to a computer using the USB cable.

2. Launch the Quiz Bowl software and select Tools ➤ Scoreboard Preferences from the Menu Bar. The Quiz Bowl Scoreboard Preferences window will be displayed.

3. Click the button of the Volume slider. Then click to the left to reduce or to the right to increase the sound effects volume of the Master Scoreboard.

4. Click OK to accept the changes, or click Cancel to leave the settings unchanged. The Scoreboard Preferences window is dismissed.

Note: See the “Adjust the Volume” instructions in the Game Play Options chapter for instructions on adjusting the Master Scoreboard volume with the Host Remote.

Problem: I accidentally deleted an Instant Quiz game (IQ-10 or IQ-20) and I want to recover it.

Solution: Import the game.

1. On the Quiz Bowl Master window menu bar, select File ➤ Import ➤ Game

   Navigate to the directory containing the Quiz Bowl default folder.
   On Mac it is:
   Applications ➤ Quiz Bowl ➤ default

   On Windows, the default install location is:
   Program Files ➤ Educational Insights, Inc. ➤ Quiz Bowl ➤ default

3. Select the file name of the Instant Quiz game you want to import. For example IQ-10.xml or IQ-20.xml

4. Click the Open button.

5. When the import process finishes, that Instant Quiz will appear in the Quiz Bowl Master window.
# A Brief Guide to the Scoreboard Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation displayed on Scoreboard</th>
<th>Meaning</th>
<th>Where to find the explanation in this guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>--CHK--</td>
<td>check</td>
<td>See the “Register the Players” section of the Playing a Game chapter.</td>
</tr>
<tr>
<td>--TM1--</td>
<td>Team 1</td>
<td>See the “Register the Players” section of the Playing a Game chapter.</td>
</tr>
<tr>
<td>PLR--1</td>
<td>Player 1</td>
<td>See the “Register the Players” section of the Playing a Game chapter.</td>
</tr>
<tr>
<td>--MIS--</td>
<td>Missing 1 Scoreboard</td>
<td>See the Troubleshooting chapter of the guide.</td>
</tr>
<tr>
<td>QB</td>
<td>Quiz Bowl</td>
<td>See the “Connect the Components” section of the Playing a Game chapter.</td>
</tr>
<tr>
<td>--B02--</td>
<td>Bonus Question number 2</td>
<td>See the “Selecting a Bonus or Tie-Breaker Question” section of the Game Play Options chapter.</td>
</tr>
<tr>
<td>--NGM--</td>
<td>No Game</td>
<td>All games have been played. You need to download games from the computer. Follow the directions in the “Download Games to the Master Scoreboard” section of the Using the Quiz Bowl Software chapter or see the Troubleshooting chapter of the guide.</td>
</tr>
<tr>
<td>--E01--</td>
<td>Error Code 1</td>
<td>See the Troubleshooting chapter of the guide.</td>
</tr>
</tbody>
</table>
BATTERY INSTALLATION

The Host and Player Remote Controls

The Host Remote requires 2 AAA batteries. Each Player Remote requires 2 AAA batteries. For the best operation, always use fresh alkaline batteries. Other battery types will have a shorter life.

1. Carefully open the battery compartment door (located on bottom of the Host Remote and on the side of each Player Remote) by loosening the screw holding it in place.

2. Install 2 fresh AAA-cell batteries in the battery compartment, carefully following the diagram showing correct battery installation. This diagram is found inside the battery compartment.
   - Batteries must be inserted with the correct polarity.
   - Do not mix old and new batteries. Do not mix different types of batteries: alkaline, standard (carbon-zinc), or rechargeable (nickel-cadmium) batteries.
   - Remove exhausted batteries from the Scoreboard.
   - The supply terminals must not be short-circuited.
   - Non-rechargeable batteries must not be recharged.
   - Do not use rechargeable batteries.
   - Only batteries of the same or equivalent type as recommended are to be used.

3. Close the battery compartment door and tighten the screw.

4. Battery life for the Host and Player Remotes is 9 to 12 months, depending on usage. It is recommended that you remove batteries from the remotes if nonuse exceeds three weeks.

Adapter Information

1. The Master Scoreboard and Accessory Scoreboards must only be used with the AC adapter included with the Scoreboards.

2. The AC adapter should be examined regularly for damage to the cord, plug, enclosure, and other parts. In the event of damage, do not use the AC adapter until the damage has been repaired.

3. The Master Scoreboard and Accessory Scoreboard are not intended for use by children under three years old.

4. The AC adapter is not a toy.

5. The Master Scoreboard and Accessory Scoreboard must not be connected to more than the recommended number of power supplies.

6. Carefully plug the AC adapter into a wall socket.

AC Adapter Cleaning Information

Disconnect the AC Adapter before cleaning. Clean it with a damp or dry cloth—do not immerse or spray any liquid or water on the AC adapter.
WARRANTY INFORMATION

Dear Customer,

Thank you for purchasing Quiz Bowl. We are certain that you will enjoy the learning fun offered by this product. Educational Insights products are guaranteed to function for one year. Educational Insights warrants each unit against factory defects in material and workmanship for one year from the date of purchase to the original purchaser only.

This warranty is invalid if the damage or defect is caused by accident, consumer abuse, or unauthorized alteration or repair. This warranty does not cover any claim concerning worn-out or defective batteries. If your Quiz Bowl unit or accessory items fail to operate satisfactorily during the first year of purchase, contact customer service at the number below, obtain a “RMA” (return material authorization) then return the item postage prepaid with your check or money order for handling and inspection. Be sure to include the product, your name, address, proof of purchase, and a brief description of the problem. Also package the item carefully to prevent damage during shipping. Send this information to the factory service center listed below. If the item is found to be defective within the first year, it will be repaired or replaced at no further cost to you.

Out of Warranty Service Policy

If any item requires service after expiration of the one-year, limited-warranty period, Educational Insights will service or replace it with a reconditioned unit—at our option—upon receipt of the item and your check or money order for the item as noted:

<table>
<thead>
<tr>
<th>In Warranty (for handling/inspection)</th>
<th>Out of Warranty</th>
</tr>
</thead>
<tbody>
<tr>
<td>EI-8495 Master Scoreboard Unit</td>
<td>$15.00</td>
</tr>
<tr>
<td>EI-8496 Accessory Scoreboard</td>
<td>$15.00</td>
</tr>
<tr>
<td>EI-8495A AC Adapter</td>
<td>$7.50 current retail</td>
</tr>
<tr>
<td>EI-8495R Player Remote</td>
<td>$7.50 current retail</td>
</tr>
<tr>
<td>EI-8495H Host Remote</td>
<td>$10.00 current retail</td>
</tr>
<tr>
<td>EI-8495S Signal Cable</td>
<td>$5.00 current retail</td>
</tr>
<tr>
<td>EI-8495U USB Cable</td>
<td>$5.00 current retail</td>
</tr>
</tbody>
</table>

Service Center
Direct all returns to: Educational Insights
Customer Service Department
380 N. Fairway Dr.
Vernon Hills, IL 60061
1-800-995-4436

We welcome your comments or questions about our product or service.

CALL: (800) 995-4436 Monday–Friday
WEBSITES: www.EducationalInsights.com
© 2007 Educational Insights, Inc., Rancho Dominguez, CA (USA).
All rights reserved. Conforms to ASTM F 963, FCC Part 15. Made in China.
Please retain this information.